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CATCHMENT DELINEATION USING
"QGIS"

1. Open QGIS Desktop 3.10.XX with GRASS 7.8 from the PC’s desktop or Go to start and search
“QGIS” and click on QGIS Desktop 3.10.xx with GRASS 7.8.

Apps  Documents  Settings  Web  More v Feedback

Best match

QGIS Desktop 3.10.10 with GRASS
@ ges - Q
App

QGIS Desktop 3.10.10 with GRASS 7.8.3

App

Apps
@ QGlIs3
a @ QGIS Desktop 3.10.10

Bk () QGIS-05Geo4W-3.10.10-2-Setup- 5 =)
¥86_64.exe

Run as administrator

i Open file location
@ (Ot Designer with QGIS 3.10.10 >

custom widgets Pin to Start

]
-+
-1 Pin to taskbar
)

Uninstall

@*ﬁ £ qgis - See web results >
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3. Click on Layer from toolbar and click on Add layer from the drop down. Now click Add Raster
Layer to add the DEM.

@ Untitled Project - QGIS
Project Edit View

DB B
LA

JETCY Settings  Plugins  Vector Raster Database Web Mesh Processing Help

8 Data Source Manager Crrl+L ;a ( B ': m e . = = %

[/, Add Vector Layer. Ctrl+Shift+V

Create Layer y

Add Layer

[ro— Embed Layers and Groups... , Add Raster Layer... Ctrl+ Shift+R
rom Layer Definition File... esh Layer..

o7 d o AdiemlysDd Fil A Add Mesh L

& 5

oot Copy Style 9,, Add Delimited Text Layer.. Ctrl+ Shift+T

" Favorites
+ [ Spatisl Bookma| | PsteStyle @, Add PostGIS Layers... Ctrl+ Shift+D.
b [&) Home Copy Layer /4 Add SpatiaLite Layer.. Ctrl+Shift=L
' E ;: Paste Layer/Group B, Add MSSQL Spatial Layer...
4 g N
OB Open Attribute Table 6 [, Add DB2 Spatial Layer... Ctrl+ Shift+2
=Y Toggle Editing ), Add Oracle Spatial Layer... Ctrl+Shift=0
r [J6 Save Layer Edits VA Add/Edit Virtual Layer,

ve Layer Edits
v OH
' Do Current Edits | @ Add WMS/WMTS Layer.. Ctrl+ Shifts W
Y O v:\ et % Add ArcGIS MapServer Layer...
' % i s yer Definition File.. @ Add WCS Layer
% GeoPack )
p s::u :fl lzge [], Remove Layer/Group Cerl+D G Add WS Layer..
el

@ rosais Duplicate Layerts) 7 Add ArcGIS FestureServer Layer.

P mssal Set Scale Visibility of Layer(s)

; g;“e Set CRS of La Ctrle Shift+C

et Project CRS from Layer

B WMS/WMTS Set Project CRS from Lay
b @B XYZTiles Layer Properties.

& wes Filter. Ctrl+F

Labeling

@ ArcGisMapServd “7 Show in Overview

&) ArcGisFeatureSs oo Show Allin Overview

% GeoMlode ©F Hide All from Overview

4. Add Raster Layer dialog box appears.

() Data Source Manager | Raster %
Source type

) Fle (I Protocol: HTTP(S), doud, etc,

Source

Raster Dataset(s) | (]

SpatiaLite

€50L

Y Oracle

DBZ* D82

.

| Cose | add | hep |
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5. Click on the browse (... icon) and select the Nagavalli_extent_utm DEM from the location and
click Open>ADD.

X
Source type
® File Protocol: HTTR(S), doud, etc.
Source
Raster Dataset(s)
4 Delimited Text
‘gd GeoPacksge (2 Open GDAL Supported Raster Dataset(s) X
’i- spatiaite « v > ThisPC > VIC(F) > qgis_training > DEM v o O SearchDEM
., Postgresal Organize v+ Newfolder = I @
& Pictures £ A Name Date modified Type Size
= Frominternet [5] nagavalli_extent_utm 0. Disc Image File
 Oracle Tolnternet |1 nagavalli_extent_utm.img.aux XML Document
.| nhp_vic » [] nagavalii_extent_utm.img.vat.cpg CPG File
DB2, pB2 cdas » ) nagavalli_extent_utm.img.vat DBF File
w e Imin_20200915 Bnagavamgxtengutm img XML Document
2001 2010 nagavalli_extent_utm.rrd RRD File
WMSAWMTS
qgis_training
Saksham
e @ OneDrive
WS
= & mis PC
B3 Arcis Map Server -
W J 3D Objects.
2= ArcGIS Feature Server [ Desktop
Documents.
[T
File name: | nagavalli_extent_utm \,‘ Al iles v

6. This adds the DEM to the Project.

Q eedreject - 65
Project fde Yeu Luyer Setings Buges Vecoe Bser Quishwe Web Meh Progessng Hep
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7. Save the project by clicking Project->Save. Save the project with a filename in the training folder.

@ SaveProject As

A4 > ThisPC » VIC(F) 5 qgis_training v

o 2 Search qgis_training

B=

Size

Organize v New folder

~

Date modified

[ This PC Namme Tpe

File folder
File folder
File folder

QGIS Project

d_cuenca_qgis
del
DEM

"% training

“J 3D Objects
[ Deskiop
Documents

& Downloads

D Music

[&] Pictures

B Videos

. Windows (C)

= VIC2(D)

- VICF)

= 55D (G)

= USBDrive (H) .,

354
22-09-2020 14:01

File name: | training

Save astype: | QGZ files (*.qg2)

A Hide Folders

8. Click on Processing Tab in toolbar and select Toolbox from the dropdown.

@ Untitled Project - OGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh [

C PR LY TS

hEB R
R@Vo L m @

Browser
TeTvTte

D History..
~ Resuts Viewer

Edit Features In-Place

BE

Favorites

v 1% Spatial Bookmarks

+ [&] Home

rOe

SN

P CTEA

P OR

RN

ST

S

SR

[P

@ Geohackage

/7 Spatialite
PastGIs

» mssaL

@
3
"
T

© ows

@ ArcGisMepServer

&) ArcGisFeatureServer
GeoNode

Layers

CcHRRT -FAL
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9. Processing Toolbox appears.

Qu

T a
RQVA8 @ e

Browser Processing Toolbox ®

ORTY®O * e 02 )
Favorites . Q search

¥ Spatial Bookmarks

§§§ ES

’ » (1) Recently used
* (&) Home » @ Cartography
PO » @ Database
» OO » @ Filetools
» CIEA b @ Graphics
r COFA b @ Interpolation
[ b @ Layertools
» O HA P @ Network znalysis
[Py b @ Raster analysis
» LIV b @ Raster terrain analysis
02N » G} Rastertools
@ GeoPackage b @ Vector analysis
/# Spatialite b+ @ Vector creation
@ rostois b+ @ Vector general
P mssaL = b @ Vector geometry
Layers b G2 Vector overlay
b @ Vector selection
o e T o-FRO » @ Vectortsble
b o GDAL
P @ GRASS
r & SAGA
Q. Type to locate (Cirl+) Read loordinate| 2.043,0.720 |95 icale| 11927803 v | @ vagnifier| 100% %/ otatior [0.0° 2| W/Render #epsGiazze @

10. Now Search r.fill.dir in the processing toolbox and Click r.fill.dir tool under GRASS.

Processing Toolbox =
¥ oA (O 2 T

U r.fil.dir
- (D Recently used

@ rfilldir
~ ) GRASS
~ Raster (")

@ rfilldir &

11. r.fill.dir dialog box appears. Now in the Elevation field, use the DEM of the basin to be
delineated.

Q@ rfilldic x

Porameters | Log r.fill.dir

Elevation
Fiters and generstes a depressionless slevation

¥ nagavali_extent_utm 1 - layer and a flow direction layer from a given
— elevation raster laver.
Output aspect directon format [opt

grass
¥ Advanced parameters
Find urresolved areas only
GRASS GIS 7 region extent (xmin, xmax, ymin, ymax) [optional]
[Leave blank to use min covering extent]
GRASS GIS 7 region cellsize (eave 0 for defauit)
0.000000

Output Rasters format options (createopt) [optional]

Output Rasters format metadata options (metaopt) [optional]

0% Cancel

Run as Batch Process. Rn | Close Help
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12. Create a folder in the training folder. Save all the outputs such as Depressionless Dem as
fill_dem.tif in the same folder. Click Run.

@ efill dir x
Farameters | Log
Sevanon
2 ragaah_sxtent_uam ]

Output aspect drection format [optoral]

gess
w Aduanced Parameters.
Fird uvesabved sreas anly

(GRASS EI5 7 region extent [opsoral]

hot sex

(GASS G157 region celsize fleave 0 for defut)
0.000000

Output Rasters format optons (reatecp) fopsonal]
Output Rasters format metadata cptirs (metsopt] [sptonsi]

Deswessioniess DEM

FiQGIS,_Traing/Catchment_QGIS Traring-Ta be Sent/fl_dem.bf
¥/ Open gt fe after running sigonthe
Fiow drection

Open culput fle afier running aigorise
prabiem areas

Open sutput e after runnng sgons

[
Bun as Batch Process.

13. The outputs will be displayed in the Layers toolbox.
Layers

« [ & T - O
bW B fill dem
~ |v| B nagavalli_extent_utm

H-:

1655

&
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14. The next process is to obtain the accumulation, to do this search r.watershed in processing
toolbox.

" rwatershed

mours ofaverens o cer e [soten

et ot detrbed L, fr LELE fior]

Tervan ok v maface fom, fr USE ol

M s o mroce: fow,Fr URE e
Cameergance facto for D 122 optonsl]

Vasinn ey e st g e ) [eptonal]

RASS G5  repon ol fnsve i et

s e P A o

15. In the r.watershed tool it is recommended to configure only the following fields:
Elevation - Select the corrected DEM (fill_dem.tif).

Minimum size of exterior watershed basin - Select the cell size of the DEM (94.8550785 m). (You
can see it in the layer properties information)

Enable Single Flow Direction (D8) - Check the box.

G rwatershed X

Parameters | Log ! r.watershed
Elevati

evation Watershed basin analysis program.
I fil_dem [J -

Locations of real depressians [aptional]
Amount of overiand fiow per cell [optiona)

Percent of disturbed land, for USLE [optional]

Terrain blocking overland surface flow, for USLE [optionai]
Minimu size of exterior watershed basin [optional]

o5l =l
Manimum length of surface flow, for USLE [optional]

Mot set =
Convergence factor for MFD (1-10) [optional]
5 -
Maximum memary to be used with -m flag (in MB) [optional]
300 =
| Enable Single Flow Direction {D8) flow (default is Multiple Flow Direction)
Enable disk swap memory option (-m): Operation is slow
Allow only horizontal and vertical flow of water
Use positive flow accumulation even for likely underestimates

Bezutify fiat areas

| 0% Cancel

Run as Batch Process Run Close: Help
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16. Number of cells that drain through each cell - Select a directory and name for the accumulation
raster as flow_accumulation.tif.

Drainage direction - Select a directory and name for the direction raster as drainage_direction.tif.

Click Run.

@ ranatershed

Farameters | Log r.watershed

Watershed basi analysis program,

Number of cels that drain through each cell

F:fagis_training /temp/flow_accumulation. tif
V| Gpen output fie after runring dlgorithm

Drainage drecton

F+fagis_training tempdrainage _direction. tf
/| Gpen output fie after runring algorithm

Unique label for each watershed basin

| Open output il after running algorithm

Stream segments

/| Open output fle after running algorithm
Half-basins

V| Gpen output fie after runring dlgorithm
Slope length and steepess (L5) factar for USLE

| Open output fie after runring algorithm
Slope steepness (5} factor for USLE

| Open output fie after running algorithm
Topographic index Infa / tan(5))

/| Open output fle after running algorithm

Stream power index a * tan(b)

Run as Batch Process Run Close Help

17. In order to delineate the basin open the tool r.water.outlet, determine the exit point in the
drainage direction raster (which shows the “water network”).

18. Add the outlet_point.shp from the training folder. Click Layer-> Add Layer=>Add Vector Layer

19. In the Name of input raster map field, select the drainage_direction.tif, and in Coordinates of
outlet point, select the coordinate of the outlet point of the basin (you can add it directly with the
marker that comes with the tool and select the outlet location near to the outlet_point.shp). Save
the output file as basin.tif. Click Run.
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Q oot x -

“
Paameters | Log r.water.outlet
Name of input raster map

3 dranage_drecton [ -
‘Coordinates of outlet pont

804751207557, 025253, 5263 [FPSGea3644]

b Advanced parameters

Basn
Fifuge_traning/tenobssn. uf
| Open outpust fie aftes runring algorithm

1 | Run as Batch Process. Run | Cose: Hep

20. Basin raster generated.

21. To obtain the polygon of the basin, it is only necessary to convert the raster to a polygon type
vector (shapefile), this can be done with the r.to.vect tool.

Under Input raster layer select the raster basin.tif, check the box Smooth corners of area features
to give a smoothing to the edges, and under Advanced parameters - v.out.ogr select area. In the
last field (vectorized tab), save the polygon in shapefile (basin.shp) format.
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Q@ rroect
®e 0 RS
™ *r.to.vect et
e o v ot a st it vk ver ™ © Recatly wad
¥ baan ) | = W tleved
restre e

= Reste 1)

W ot
Name of st cob 1 s vake fsotonsl]
-
V. Smast e of e fesnses
(R ——
Vit raster vaes 2 1 cordte

Bt bl vector gy

Dot v st sk
v Aibramced parameters

GRASE GI 7reguryestent (e, s, e, o) ool

[eave bk 0 use i coverrg vl

RASS G g ctine fee 0 i cefaut]

vt o ot o) optor]

vt gy usputisyer psons ) opscns]

ety Resuts am
E R Y LAEN
Feanue a

= flow_sccumulston
Eand

s s/ basn o

o A 3
[

Cancel
Fury o Bt Process

22. The basin polygon is generated.

23. To obtain the vector of the water network use the r.stream.extract tool.
Input map - elevation map - Select from the corrected DEM (fill_dem.tif)

Minimum flow accumulation for streams - Select a value to set the density of the water network, in
this example 25000 is used, but it can be increased or decreased (this value depends on the size of

the raster pixel, if you need to decrease the density you must increase the value or vice versa, this
can also be done with a raster calculator).

Advanced parameters - v.out.ogr - select line.

Unique streams ids (vect) -Select a directory and name for the water network vector.
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als
Mertganery st forsope otone]

[ac0000 al
Dokt sream segment st hn s cptona].

I CAE
e 570 abv i e fpina]

nonoee g
v advanced parameters

Mo ey o e e i M) optnal]
0

a |z
(GRASS GIS 7regen extent s, e, o ) options]

[ L]
G IS 7regin el feave o defnst)
0000

5
gt astes fomt oters (resteant) fptens]

‘Oufgut Rasters forms metadsta optons [metacot) fptonsl]

v.aut.ogr outnslsyer ptns fen) optonl]

ke e s as)
[ave o ooy el

O outpt e aftr runring skarbm

e svesm s foect)

|Frioge_ranngteng ectorjwater reteors_La |
! Ocen output e afer urring skorbm.

R 20 Bach Process._

24. Final stream network is generated.

25. In order to delineate individual sub basins, the value of minimum size of exterior watershed
basin has to be changed accordingly. Repeat step 23.
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@ rwatershed

Pasneters | Log
Eevaten

¥ fdem ()
Locations of real depressions [aptionsl]

Amount of averland flav ger cel (optional]
Percent o dsiurbed ), for USLE [opiional]
Tesrain bladng overand surface fow, for USLE [aptonal]

Mmum e of exterir watershed bash fopiional]
100000

Mammum length of sur face flaw, far USLE (optional]

ot set

Convergence factor for MFD {1-10) [aptonal)

s

Maximum memory 1o be Laed with - flag 0n M) [optional)
00

v

Enable disk swap memory opton (m): Cperaton i sow:

Alow only harzantal ard vertical fow of water

Usa posiive flow accumdation even fe lkely underestmates

Beautfy flat aress
v Advonced Parameters

GRASS G15 7 regon extant [optonal]

ot set

GRASS GIS 7 regon celsize (leave 0 for defoult)

0.000900

Output Rasters format optons (createopt] (optional]

Rhumber of cels that drain thrcugh each cel [aptianal]
F+/QG15_Traing Catchment_QGIS _Training - To be Sent/yial 4 /fow_accumulaton, f
¥ Open output ik aftr runring algorthm

Oranage drecton [opsonal]

PGS _QGIS Training- _drection,bf

[ R s e Process.
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Q rwatershed

P

Beautfy fst aresz
w Advanced Parameters

GRASS GIS 7 region extent [optional]

Hot set
(GASS 615 7 region celsze eave O for defoult)

0.000000
Cutpit Rasters format aotions (reatecot) [optinall

Hber ofcels that s Bauch each cef foptons]
FQGIS Trsring/Catchment QG Trsring-To be Sentfvial1/flom_Scamulaton 5
V. o autout e sfter ruing sigarite

Drainage drection [aptonal]

FgEs QIS _Traring: . drechon.bf
¥ Opm cutput e afer g sigariten

unvaue labe for ach watershed basn [sgonal]

F1IQGIS._Traring Catchment_QGIS_Traring- To b SentwialLirvaue_lsbel_for_sach watershed.of
V' pan autput fle after runing akgortem
‘Stream segments [optional]

LTS, Q5] _segment. i

V' Open output fle after running aigorithm
Halthasis [apbons]
(Save to temoorary fle]
O oot fle afte e sigritn
Sope length and stecpness (5) factor for USLE [optional]
[Save 1o temporary fie]
Open output i after g aigerite
Sope steepness (5) factor far USLE [optional]

[5ave o temporary fle]
Open autput fle after ruming aigarithm
‘Tapooraghic index Infa / tan(bl) (aotional]

[Save 1o temparary fle]

Opn output fle afes runing Kot
Streem power ndex & * tan(s) [apbonsl]
[Save to temaorary fie]

Open owtot e st g sigritn

[Ru s Bt Process

@ rstream extract

[rm——
Trnput map: elevation map.

¥ figem |

Irput map: accumaton map [optonall

Ireuit map: map with real depressions (aptonal]

Mrvmum fiemw acumuation for shreams.

100000,090000
Monigomery exponent for slope [options]

0.000000
Delete streom segments shorter than cels [optiona]
[

Use 57D above this threshold [optional]

notset

w Advanced Parameters
Maximum memary o be used (n M) [apsonal]
30

GRASS GIS 7 region extent foptonal]

Mot set

GRASS CIS 7 region eelsize (eave D for defaull)

0.000000
Ot Rasters format cptirs (assteopt] (optne]

Output Resters format metadata aptons (etocpt) [sptonal]

w.out.ogr output type

Ine

.0uL. 0 QutDUt data source aptons (dsco) foptionall

wout ogr output sy aptons o) fploral]

Al exper e oy ith category are export=d

Unque stream ids (rast) [aptonal]

[Saue 10 temcacars Flel

| Run a8 Batch Process._.|
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26. Clip the unique_label_for_each_watershed and stream using Basin shapefile that was generated
in step 22.

Qaw Q Chp Raster by Mask Layer x
[— teamsirs [ling)

Ireutiers - routlers o
Vi -l A L | 3¢ e Jalor_sach veshed [ -]
) sebce femnres iy Hasklayr

vyl o Fbon ) L)~ I
| S -l A L S Featres iy

] sebce fesres iy e G ptera]

Cooed L R Y]
FREIS_TramegiCatcment QIS Trsig- Toke Senfvi Ustresn L all. Torgen S optana]

'/ Open sutput e ot g s L -1

s ———— vy —.
otant I

Croate cutiut ot

' Maih the xtent of e oped rasie o e extznt of e masklaver
aep et o rout st

| etoupun e eschuson

Ressitn Ut bonds sptor]

[ Hama talue ]

[ [ | [ vbaate | [ e |

Ot ot trm

Uve It s Dot e -
885onl commang e permeters [ptars]

ppssfpas

s, s Tranns ot a
B

GEALICGH corce ol

I < T cutive /615 Tarwmg-Tabe  dbann pre Traneg- Tobe
oty G TomeaiCamert QG T 1o b e e ;30 e iR Tanes Kokt 3 Trabw-To b e

Run aa ach Frocess.. 8un s Bt procem. B || com || we |

27. Convert the clipped sub-basin raster into vector.
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